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Введение 
 

Методические рекомендации составлены в соответствии с рабочей про-
граммой по курсу «Графический дизайн» для студентов направления подготов-
ки 15.03.03 «Прикладная механика» очной формы обучения.  

Целью изучения дисциплины «Графический дизайн» является формирова-
ние у студентов знаний и навыков графического дизайна. 

Blender  это программный комплекс, позволяющий создавать реальный и 
красочный трехмерный мир. Его возможности сравнимы с популярными ком-
мерческими пакетами, такими как Maya, 3ds Мах, и даже в чем-то превосходят 
их. С помощью свободного инструментария Blender вы можете создавать моде-
ли, работать с анимацией, использовать законы физики для имитации природ-
ных явлений [1, 2]. 

В методических рекомендациях в краткой форме изложены цель, содержа-
ние и порядок выполнения лабораторных работ. 

Отчет по лабораторной работе представляет собой файл Blender с выпол-
ненным заданием по теме лабораторного занятия. 

Методические рекомендации предназначены для самостоятельной подго-
товки студентов к лабораторным занятиям по дисциплине «Графический       
дизайн». 
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1 Лабораторная работа № 1. Графический редактор Blender 
 

Цель работы: изучение интерфейса и основных приемов работы в графи-
ческом редакторе Blender.  

 

Теоретические основы  
 
Blender – это открытый и свободно распространяемый графический редак-

тор для создания трехмерной компьютерной графики, анимации и интерактив-
ных приложений. 

Запуск программы осуществляется через главное меню или по ярлыку на 
рабочем столе. Для выбора русскоязычного интерфейса следует выполнить 
действия: File → User preferences → вкладка System → в окне International fonts 
выбрать язык Русский, отметить пункты Interface, Tooltips, New Data и нажать 
кнопку «Сохранить настройки». 

Рабочее окно Blender показано на рисунке 1.1. 
 

 
 
Рисунок 1.1 – Рабочее окно редактора Blender 
 
Сцена, созданная в Blender, – это еще не изображение. Чтобы получить из 

сцены графический файл необходимо «отрендерить» файл. Формирование 
изображения по созданной сцене называется рендерингом (отрисовкой). 
В Blender, чтобы посмотреть конечное изображение следует нажать клавишу 
F12. Отображаемая сторона, удаленность и другие параметры на получившемся 
изображении зависят от того, где размещена и как повернута камера. 

Blender использует единицу измерения с предсказуемым названием Еди-
ница Blender (Blender Unit, BU). Единица Blender это размер одного квадрата 
фоновой сетки в 3D-окне Blender. При работе с моделями в определенном мас-
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штабе необходимо решить, какому реальному размеру будет соответствовать 
одна BU и выполнять работу в соответствующей пропорции. 

Многие команды в Blender предпочтительно выполнять с клавиатуры. При 
этом следует помнить, что курсор мыши должен находиться именно в том окне, 
где планируется произвести изменения. 

Изменять вид окна просмотра можно не только с помощью клавиатуры, но 
и используя мышь (курсор мыши при этом должен находиться в 3D-окне). 

Присутствующие на сцене объекты можно передвигать, менять угол 
наклона и производить ряд дополнительных операций. Для этого необходимо 
выделить объект, выделение осуществляется правым щелчком мыши по вы-
бранному объекту, в результате контур выделенного объекта будет окрашен 
другим цветом. Чтобы выделить несколько объектов, необходимо по очереди 
выделять объекты правой кнопкой мыши, удерживая клавишу Shift. 

 
Порядок выполнения работы 
 
Изучить графические элементы рабочего окна Blender. Выполнить ренде-

ринг объекта «куб». 
 
Вопросы для самоконтроля 
 
1 Какие элементы содержит рабочее окно Blender? 
2 Как выделять объекты в Blender? 
3 Как отрендерить сцену? 
4 Какие единицы измерения в Blender? 
 
2 Лабораторная работа № 2. Основные операции по работе 

с объектами 
 

Цель работы: изучить основные операции по работе с объектами в 
Blender. 

 
Теоретические основы  
 
Выполнять различные преобразования объектов, например, изменять ме-

стоположение, размер и разворот объектов можно как с помощью клавиатуры, 
так и с помощью кнопок, расположенных в меню 3D-окна.  

Для изменения размера объекта по всем осям с помощью клавиатуры 
необходимо выполнить следующие действия:  

– выделить объект;  
– выбрать режим просмотра «вид справа»;  
– расположить курсор мыши в 3D-окне в соответствии со следующей за-

кономерностью: чем ближе курсор к центру объекта, тем больше будет произ-



 7

водить изменения малейшее движение мыши; чем дальше курсор от центра 
объекта, тем слабее будет влияние движения мыши; 

– нажать клавишу S (не удерживать);  
– перемещать курсор мыши, пока объект не достигнет необходимого размера;  
– щелкнуть левой клавишей мыши, чтобы согласиться с изменениями, или 

правой – чтобы отказаться от них. 
Для изменения местоположения объекта на сцене используется клавиша G, 

для поворота – R. Данные клавиши S, G и R не случайно выбраны для выпол-
нения действий: S – первая буква английского слова size (размер), G – go (дви-
жение), а R – rotation (вращение). Если изменения необходимо выполнить толь-
ко по одной оси, то после соответствующей клавиши следует нажать X или Y 
или Z, в зависимости от того, по какой оси требуется изменить объект. 

После включения любой из этих трех кнопок у выделенного объекта появ-
ляются маркеры. Для внесения изменений следует навести курсор мыши на 
маркер, нажать левую кнопку и перемешать мышь. 

Экструдирование – это один из инструментов, позволяющих изменять 
имеющийся в редакторе ограниченный набор объектов, таких как куб, цилиндр, 
сфера и т. д. Инструмент Extrude позволяет изменять объекты в режиме редак-
тирования за счет создания копий вершин, ребер и граней и их последующего 
перемещения, а также изменения размеров (если это ребра или грани). 

Имеющиеся в редакторе mesh-объекты имеют ограниченный набор 
подобъектов (вершин, ребер, граней) и их количество может оказаться недоста-
точным при создании сложных объектов. Еще одним из инструментов, позво-
ляющих изменять исходные объекты, является инструмент подразделения или 
subdivide. Инструмент подразделения позволяет разделить объект на составные 
части (ребра и грани). 

Для подразделения исходного объекта на составные части необходимо вы-
полнить следующие действия:  

– включить режим редактирования; 
– выделить требуемый подобъект (грань или ребро); 
– включить инструмент подразделения клавишей W и в открывшемся 

списке команд выбрать «подразделить». 
Если была выделена грань, то в результате подразделения образуется че-

тыре грани. Если было выделено ребро – исходное ребро будет разделено на 
два ребра точкой посередине (получится два ребра). Инструмент подразделения 
можно применять неоднократно и тем самым получать большее количество бо-
лее мелких составных частей. 

 
Порядок выполнения работы 
 
1 Молекула воды. 
Создать новый файл, удалить из сцены куб. Добавить на сцену цилиндр, 

выполнив действия: Добавить → Поверхность → Цилиндр. Уменьшить ци-
линдр по всем осям до 0,3 единиц. Для этого нажать S, затем, удерживая Ctrl, 
двигать мышью пока значения в левом нижнем углу 3D-окна не станут равны-
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ми 0,3 или установить точный размер в окне слева. Зафиксировать изменения, 
щелкнув левой клавишей мыши.  

Установить просмотр в режиме вид спереди. Увеличить цилиндр по оси Z. 
Для этого нажать S, затем Z, и, удерживая Ctrl, двигать мышью пока значение в 
левом нижнем углу 3D-окна не станет равным 7,5. Зафиксировать изменения, 
щелкнув левой клавишей мыши.  

Повернуть цилиндр на 90 градусов по оси Y. Для этого нажать R, затем Y,  
и, удерживая Ctrl, двигать мышью пока значение в левом нижнем углу 3D-окна 
не станет равным 90. Зафиксировать изменения, щелкнув левой клавишей мыши.  

Продублировать цилиндр. Копию переместить по оси X так, чтобы два ци-
линдра касались друг друга. Для этого следует выполнить действия: Объект → 
Дублировать. Возможно также использование клавиш: дублирование выполня-
ется сочетанием клавиш Shift + D, далее клавиша X для выполнения сдвига, за-
тем выполнить перемещение с помощью мыши.  

Поскольку в молекуле воды угол связи H-O-H равен 104,5 градусов, то 
первый цилиндр нужно развернуть по оси Y на 75,5 градусов (180 – 104,5). Для 
этого используем клавиши R, далее Y и мышью выполнить поворот. Подкор-
ректировать угол наклона также можно в окне слева. Далее, двигая стрелки, 
совместить концы цилиндров. 

Разместить 3D-курсор в точке соединения двух цилиндров. Добавить сфе-
ру (она будет служить моделью атома кислорода). Два раза продублировать 
сферу, а дубликаты перенести на концы цилиндров. Уменьшить размеры дуб-
ликатов до 0,8 (клавиша S и движение мышью). 

Объединить все элементы модели. Для этого следует выделить все объек-
ты и выполнить действия Объект → Объединить. Переключиться на вид из ка-
меры. С помощью инструментов перемещения и поворота откорректировать 
размещение модели на сцене. Сохранить файл. Выполнить рендеринг. Резуль-
тат моделирования показан на рисунке 2.1. 

 

 
 
Рисунок 2.1 – Рендеринг сцены модели молекулы воды 
 
2 Экструдирование объекта «куб». 
Создать новый файл в Blender. Перейти в режим редактирования, нажав 

клавишу Tab. После этого в нижней части 3D-окна появятся кнопки для вклю-
чения режима редактирования подобъектов: вершин, ребер и граней. 

Далее, для того чтобы выполнить экструдирование какого-либо подобъек-
та следует включить инструмент экструдирования. Включить инструмент экс-
трудирования можно различными способами. Наиболее удобным является ис-
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пользование клавиши Е (английская раскладка клавиатуры). После этого следу-
ет выделить подобъект и движением мыши указать направление «выдавлива-
ния». Чтобы выдавить подобъект точно по требуемому направлению, после 
нажатия клавиши E с помощью клавиш X или Y или Z следует выбрать ось, по 
которой будет перемещаться подобъект. Для того чтобы зафиксировать изме-
нения после перемещения нужно щелкнуть левой клавишей мыши (для отме-
ны – правой). 

Для этого следует выбрать соответствующий режим, выделить вершину и 
включить инструмент экструдирования. Местоположение новой вершины мож-
но отрегулировать с помощью мыши. Вместе с новой вершиной появится и еще 
одно ребро, связывающее эту вершину с исходной. 

Пусть требуется выполнить выдавливание ребра по оси OZ. Для этого 
нужно включить режим редактирования ребра, включить инструмент экструди-
рования, нажав клавиши Е и Z. После того как появился новый подобъект мож-
но изменить его размер и угол наклона.  

В Blender возможно экструдирование как одной грани, так и нескольких 
граней одновременно. Выдавливание одной из граней выполняется аналогично 
приемам выдавливания вершин и ребер. Для выдавливания нескольких граней 
одновременно (необязательно соседних) необходимо сначала эти грани выде-
лить: выделить первую грань, удерживая клавишу Shift, выделить вторую грань 
и включить инструмент экструдирования. 

На рисунке 2.2 показан результат экструдирования объекта «куб». Полу-
чившийся объект был сделан из куба путем его превращения в брусок (прямо-
угольный параллелепипед) и последующего экструдирования граней. Размер 
новых граней был изменен, также они были смещены. 

 

 
 
Рисунок 2.2 – Пример экструдирование куба 
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3 Создание модели стола. 
Создать новый файл. Изменить объект «куб» (это будет столешница). При-

менив инструменты подразделения и экструдирования, получить ножки стола. 
Переключившись в режим объекта, выполнить необходимые преобразова-

ния (например, вращение). Результат моделирования показан на рисунке 2.3. 
 

 
 
Рисунок 2.3 – Модель стола 
 
Вопросы для самоконтроля 
 
1 Для чего используется инструмент экструдирования? 
2 Для чего используется инструмент подразделения? 
3 Для чего используется инструмент подразделения? 
 
3 Лабораторная работа № 3. Сеточные модели 

 
Цель работы: научиться использовать сеточные модели и модификаторы в 

Blender.  
 
Теоретические основы  
 
Симметричное моделирование – это способ создания объекта, когда пользо-

ватель создает часть модели, а программа зеркально достраивает все остальное. 
Lattice (Решетка) – это вспомогательный объект, который не отображается 

при обработке сцены, но позволяет деформировать модель. 
Для использования Lattice нужно выполнить следующее: 
– добавить в сцену сам объект из меню Add / Lattice; 
– добавить модификатор Lattice к модели, которую нужно деформировать; 
– выбрать в модификаторе имеющийся в сцене объект Lattice. 
Решетка подчиняется тем же правилам манипуляций, что и другие объек-

ты. Теперь рассмотрим панель модификатора Lattice. Всего там находятся три 
опции: 

– Object (Объект) – при щелчке по полю откроется меню, где можно вы-
брать из списка объект Lattice; 
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– Vertex Group (Группа вершин) – если модель имеет созданные группы 
вершин, то это поле позволяет выбрать одну из них. В таком случае Lattice бу-
дет работать только с группой; 

– Strenght (Сила) – степень деформации (при 1 – максимальная). 
Изменение формы модели осуществляется в режиме редактирования объ-

екта Lattice. 
В отличие от обычных примитивов, здесь доступно перемещение, масшта-

бирование и ротация только вершин. Собственно, манипуляции с вершинами 
Lattice влияют на деформацию модели. 

Для работы над высокополигональной моделью лучше воспользоваться 
следующим алгоритмом: 

– создание низкополигональной модели; 
– разбиение ее с помощью Subdivide (Разбиение) на минимально достаточ-

ное количество элементов для работы над формой; 
– использование модификатора Multires (Многоуровневая детализация), 

который позволяет контролировать качество структуры; 
– «обтесывание» формы с помощью инструментов скульптурного модели-

рования. 
 
Порядок выполнения работы 
 
1 Лампа. 
Откройте Blender, при этом загружается сцена, установленная по умолча-

нию: куб в начале координат, камера и лампа. 
Перейдите в режим редактирования (Edit Mode), нажав клавишу Tab. От-

мените выделение вершин, нажав на клавишу A. 
Нажмите клавишу B, чтобы перейти в режим выделения прямоугольником. 

Обведите левой кнопкой мыши все 4 вершины верхней грани. Чтобы свести их 
вместе и построить пирамиду, применим масштабирование с коэффициентом 0. 
Для этого нужно нажать клавишу S, набрать на клавиатуре 0 и нажать Enter. 
Теперь 4 вершины находятся в одной точке. 

Чтобы оставить только одну вершину из этих четырех, щелкните по кноп-
ке Удалить двойные вершины (Remove Doubles ) на панели инструментов (в ле-
вой части окна). Убедитесь, что справа в заголовке окна появилось сообщение 
«Удалено 3 вершины». 

Нажмите на клавиши Ctrl+Tab и выберите в появившемся всплывающем 
меню пункт Ребро (Edges), чтобы включить режим выделения ребер. 

Перейдите к виду сверху (Num7) и выделите все 4 наклонных ребра (ПКМ 
при нажатой клавише Shift). Щелкните по кнопке Подразделить (Subdivide) на 
панели инструментов слева и установите Количество разрезов (Number of Cuts), 
равное 3 (чтобы разбить каждое ребро на 4 равных части). Пирамида будет раз-
делена на 4 слоя. 

Включите режим работы с вершинами. Чтобы построить усеченную пира-
миду, выделите вершину и нажмите клавишу Delete. Появится всплывающее 
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меню, в котором нужно выбрать удаляемые элементы. Выберите Вершины 
(Vertices). Посмотрите на пирамиду сверху – появилось отверстие в торце. 

Нажмите клавишу C (круговое выделение), колесиком мыши отрегулируй-
те область выделения, которая обозначается белой точечной окружностью. Вы-
делите с помощью левой клавиши мыши все 4 верхние вершины и нажмите 
клавишу Esc, чтобы закончить выделение. 

Чтобы создать закрывающую грань сверху, нажмите клавишу F. 
Выделите первый промежуточный ряд вершин, нажав клавишу Alt и 

щелкнув по одному из ребер, образующих контур. Применив масштабирование 
(клавиша S), уменьшите размеры контура. 

Включите режим работы с гранями. Поверните объект так, чтобы видеть 
нижнюю грань, и выделите ее. Нажмите кнопку E и переместите выделенную 
грань вниз примерно так, как на рисунке 3.1. Используя масштабирование, 
уменьшите размеры нижней грани. Затем, используя дважды выдавливание и 
масштабирование, завершите построение нижней части. Добавьте колечко, за 
которое такой фонарь можно подвесить – это объект Тор (Torus). 

 

 
 
Рисунок 3.1 – Модель лампы 
 
2 Куб. 
Откройте Blender со сценой по умолчанию. Перейдите к виду сверху (кла-

виша Num7) и включите режим работы с гранями (клавиши Ctrl+Tab). Сейчас 
мы построим нестандартную разбивку верхней грани куба так, как показано на 
рисунке 3.2. 

 

 
 
Рисунок 3.2 – Разбивка верхней грани куба 
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Перейдите в режим редактирования (клавиша Tab) и отмените выделение 
всех граней (клавиша A). Проверьте, чтобы кнопка в нижней части рабочей об-
ласти, которая ограничивает выделение только видимыми гранями (запрещает 
выделение на обратной стороне фигуры), была включена. 

Перейдите к ортографической проекции (Num5). Выделите и удалите 
верхнюю грань: нажмите клавишу Delete, во всплывающем меню выберите 
объекты для удаления Грани (Faces). 

Переключитесь в режим работы с ребрами (Ctrl+Tab). Выделите 4 верхних 
ребра и разбейте их пополам с помощью инструмента Подразделить (Subdivide). 

Выделите только что добавленные вершины в серединах ребер и соедини-
те их новой гранью (клавиша F). Затем выделите все верхние угловые вершины 
и снова нажмите клавишу F, чтобы достроить 4 угловых грани на верхней сто-
роне куба. 

Перейдите в режим работы с гранями и выделите центральную грань. 
Нажмите клавишу E и выдавите эту грань вверх. Снова нажмите клавишу E  
и сразу Enter, чтобы продублировать угловые вершины. С помощью масштаби-
рования (клавиша S) уменьшите размер грани и вдавите ее вниз (клавиша E). 
Полученная модель приведена на рисунке 3.3. 

 

 
 
Рисунок 3.3 – Разбивка верхней грани куба 
 
3 Голова слона. 
Создайте новую сцену. Выделите куб и удалите его (клавиша Delete). 
Добавьте на сцену новый объект – сферу (UV-sphere) и уменьшите число 

ее сегментов до 16. 
Включите вид спереди (клавиша Num1), ортографическую проекцию 

(Num5) и перейдите в режим редактирования (Edit Mode) с помощью клавиши 
Tab. Отмените выделение (клавиша A). Включите режим работы с гранями 
(Ctrl+Tab). С помощью инструмента Разрезать петлей со сдвигом (Loop Cut and 
Slide) сделайте два сечения по «меридианам», как показано на рисунке 3.4. 
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Рисунок 3.4 – Редактирование сферы 
 
Выделите четыре центральных грани и удалите их (клавиша Delete, во 

всплывающем меню выбрать Грани, Faces). 
Перейдите в режим работы с вершинами, выделите четыре вершины, как 

показано на рисунке, и постройте грань между ними (клавиша F). Достройте 
оставшиеся треугольные грани. 

Переключитесь в режим редактирования граней, выделите центральную 
грань и перейдите к виду справа (Num3). Нажмите клавишу Ctrl и, удерживая 
ее, щелчками мыши постройте хобот. 

Выделите грань в торце хобота, нажмите клавише E (выдавливание) и сра-
зу же клавишу Enter (будет создана копия всего контура грани). Затем снова 
нажмите клавишу E и вдавите торец внутрь хобота. 

Примените модификатор Подразделение поверхности (Subdivision surface). 
Для этого нужно перейти на страницу свойств Модификаторы (Modifiers), 
щелкнуть по кнопке Добавить модификатор (Add Modifier) и выбрать модифи-
катор Подразделение поверхности (Subdivision surface). 

В свойствах модификатора в поле Вид (View) увеличьте число делений 
грани при просмотре до 2. Включите режим редактирования сеточной модели. 

Выделите 4 грани из которых будем строить глаз. Удалите их и постройте 
такую же сетку, как для выдавливания хобота. 

Выделите центральную грань отмеченной части, нажмите клавишу E (выдав-
ливание) и сразу же клавишу Enter (будет создана копия всего контура грани).  
Затем постройте внутренний контур, используя масштабирование (клавиша E). 
Затем снова нажмите клавишу E и вдавите центральную грань немного внутрь. 

Перейдите к виду сверху и передвиньте вершину над глазом немного впе-
ред. Перейдите к виду спереди. Выделите две грани, в которых будут уголки 
рта, и удалите их.  

Выделите 4 грани и вдавите их внутрь. Перейдите к виду спереди и изме-
ните положение вершин так, чтобы рот стал улыбающимся. 

Перейдите к виду справа и примените инструмент Разрезать петлей со 
сдвигом (Loop Cut and Slide) для одной из граней. Затем выделите 5 граней и 
примените выдавливание (клавиша E). После этого используйте масштабирова-
ние (клавиша S) и затем снова выдавливание. На рисунке 3.5 представлена по-
лученная модель. 
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Рисунок 3.5 – Редактирование головы слона 
 

Перейдите к виду спереди. Проверьте, чтобы кнопка, которая ограничива-
ет выделение только видимыми гранями (запрещает выделение на обратной 
стороне фигуры), была отключена. Включите режим работы с гранями и 
нажмите клавишу B (выделение прямоугольником) и выделите все грани левой 
части фигуры. Повертев модель, проверьте, чтобы были выделены все грани в 
левой части головы. Если какие-то грани остались невыделенными, добавьте их 
к выделению щелчком правой клавиши мыши при нажатой клавише Shift. Уда-
лите выделенные грани. 

Примените к оставшейся половине модификатор Отражение (Mirror). 
Переключитесь в режим объектов (Object Mode), нажав клавишу Tab,  

и найдите шов на границе между половинками. С помощью кнопок со стрелка-
ми на странице свойств Модификаторы (Modifiers) поменяйте порядок приме-
нения модификаторов. Шов должен стать практически незаметен.  

Добавьте 2 небольшие сферы и установите их внутрь глазных впадин. Пе-
ремещая вершины, исправьте форму ушей так, как показано на рисунке 3.6. 

 

 
 
Рисунок 3.6 – Модель головы слона 
 
4 Пуфик. 
Выделите куб и уменьшите его по оси Z примерно вдвое. После этого пе-

рейдите в режим редактирования (Tab) и добавьте 6 разрезов (Ctrl + R) как по-
казано на рисунке 3.7, а. Добавьте еще по 3 разреза возле каждого (18 разрезов), 
как показано на рисунке 3.7, б. Добавьте еще по 4 разреза между каждыми че-
тырьмя уже сделанными (еще 32 разреза), как показано на рисунке 3.7, в. 
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а)    б)    в) 

 
 
Рисунок 3.7 – Модель куба с разрезами 
 
Выделите в каждом из 16 образовавшихся секторов центральную грань 

(С), включите режим пропорционального редактирования (O) с типом Root (на 
панели снизу) и поднимите выделенные вершины по оси Z (синяя стрелка), 
чтобы придать форму, как на рисунке 3.8, а. 

Теперь выделите 4 угловых ребра, сведите их немного в центр, чтобы 
округлить форму куба, а также уменьшите их длину по оси Z. Перейдите на вид 
спереди/сбоку, ортогональный режим, выделите все нижние вершины и выров-
няйте их по одной линии (S/Z/0/Enter). После этого добавьте сбоку 2–3 ребра 
(Ctrl + R) и немного округлите боковую грань, как показано на рисунке 3.8, б. 

Выделите 12 разрезов, как показано на рисунке, разведите их немного в 
сторону и приподнимите по оси Z, как показано на рисунке 3.8, в. 

 
а)    б)      в) 

 
 
Рисунок 3.8 – Модель куба со скругленными выступами 
 
Примените модификатор Subdivision Surface в уровень 2 и шейдер Smooth. 

Результат должен быть, как на рисунке 3.9, а. 
Добавьте в сцену UV-сферу с числом сегментов и колец равным 10. 

Уменьшите ее масштаб, а также сплюсните ее по оси Z. Примените к ней мо-
дификатор Subdivision Surface в уровень 2 и шейдер Smooth (рисунок 3.9, б). 

Создайте еще 8 копий сферы (Alt + D), расположите каждую на своем ме-
сте, а затем объедините все сферы и куб в один Mesh-объект (Ctrl + J) (рису-
нок 3.9, в). 

Добавьте в сцену еще один куб и уменьшите его масштаб до размеров под-
ставки. Примените к нему два модификатора и шейдер Smooth (рисунок 3.9, г). 
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а)    б)      в) 

 
 

г) 

 
 
Рисунок 3.9 – Модель пуфика 
 
Вопросы для самоконтроля 
 
1 Для чего применяется симметричное моделирование? 
2 Как применить симметричное моделирование? 
3 Как использовать объект Lattice? 
4 Как создать высокополигональную модель? 
 
4 Лабораторная работа № 4. Кривые 

 
Цель работы: изучить принципы работы с кривыми в Blender. 
 
Теоретические основы  
 
Кривые или, как их еще называют, сплайны – это примитивы, создаваемые 

программой на основе определенных математических функций. 
Кривые и примитивы, созданные на их основе, обладают одним неоспори-

мым плюсом, а именно – гибким и эффективным редактированием. В принци-
пе, с помощью этих примитивов можно создавать объекты любой формы. 

Blender предлагает две группы примитивов, основанных на использовании 
математических функций: Curve (Кривая) и Surface (Поверхность). Если первые 
представляют собой простые двумерные объекты, то вторые – это полноцен-
ные, замкнутые фигуры. Кроме того, они различаются по типу расчетной функ-
ции: Bezier (Безье) и NURBS (Неоднородный рациональный В-сплайн). 
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Редактирование сплайнов осуществляется только с помощью вершин или, 
как их еще называют, контрольных точек. 

Контрольные точки – это узлы кривой или поверхности, с помощью кото-
рых изменяется форма примитива. Эти вершины подчиняются общим правилам 
манипулирования. Их можно перемещать, вращать и масштабировать. В свою 
очередь, контрольные точки кривых Безье имеют рычаги. 

Рычаги – это элементы, позволяющие управлять изгибом кривой между 
контрольными точками. Каждая вершина снабжается двумя рычагами, которые 
ответственны за свой сегмент. Таким образом, процесс редактирования сплай-
нов Безье заключается в размещении ключевых вершин в нужных местах и ре-
гулировании переходов между ними с помощью рычагов. 

Blender предлагает несколько типов рычагов для разных нужд: 
– Automatic (Автоматический) – используется по умолчанию. В этом ре-

жиме оба рычага взаимосвязаны, и при изменении положения одного равно-
ценно меняются координаты второго; 

– Vector (Векторный) – рычаг всегда смотрит в сторону следующей кон-
трольной точки. Соответствующим образом изменяется и кривая. Этим спосо-
бом можно добиться у сплайна острых углов; 

– Aligned (Выровненный) – в этом режиме рычаг устанавливается парал-
лельно по отношению к соседнему рычагу; 

– Free (Свободный) – в отличие от остальных типов, здесь рычаги полно-
стью независимы друг от друга. 

Примитивы Curve: 
– Bezier – простая кривая с двумя контрольными точками; 
– Circle – замкнутая окружность с четырьмя управляющими вершинами; 
– Nurbs Curve – простая кривая NURBS с четырьмя вершинами; 
– Nurbs Cicle – замкнутая окружность с восемью контрольными точками; 
– Path – вспомогательная кривая для создания траектории движения друго-

го объекта. 
Простейшая модель, которую можно сделать из кривой (конкретно имеет-

ся в виду примитив Bezier), – это волос, провод, труба и все остальное в таком 
роде. Blender предлагает два варианта создания объема у сплайнов: Extrude 
(Выдавливание) и Depth (Глубина). Обе опции находятся в закладке Geometry 
(Геометрия) окна Properties. Если функция Extrude выдавливает объем по коор-
динате Z, то Depth производит это с «гранями» кривой. 

В отличие от рассмотренных кривых Безье, NURBS имеют совершенно 
иные структуру и способы редактирования. По сравнению с Безье, поверхности 
можно рассматривать как трехмерные объекты, но с очень большой натяжкой. 
С одной стороны, у них есть дополнительное измерение, с другой стороны, все 
поверхности, даже зацикленные, не имеют объема. По логике, трехмерными 
объектами могут называться только те, что имеют объем. И все же в сравнении 
с простыми кривыми NURBS являются трехмерными.  

Режим редактирования не позволяет напрямую менять объект. С помощью 
вспомогательной решетки можно лишь влиять на поведение объекта. В отно-
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шении NURBS важно знать, что решетка имеет два измерения: U и V. В режиме 
редактирования ребра U окрашены желтым цветом, а V – розовым. 

Для изменения формы примитива существуют контрольные точки, но, 
в отличие от Безье, тут не имеется рычагов, и они всегда управляются в про-
странстве 3D. 

В отличие от сплайнов, изменять количество элементов структуры решет-
ки возможно только целиком по одному из направлений. Это справедливо для 
всех остальных операций, таких как Extrude. Delete, Subdivide. 

Рассмотрим основные способы редактирования поверхности. 
Редактирование формы – как уже было сказано, здесь нет отличий от той 

же работы с кривыми Безье. Выделяется вершина или группа вершин и выполня-
ется стандартное манипулирование: перемещение, масштабирование, поворот. 

Добавление ребер – эту задачу можно выполнить, к примеру, при помощи 
команды Extrude и только для крайних сторон решетки. Для центральных ребер 
выдавливание невозможно. Необходимо выделить все точки нужной стороны и 
нажать клавишу Е. 

Удаление ребер – принцип все тот же. Выделяется с помощью Shift+R реб-
ро нужного направления и выполняется команда Delete. В отличие от Extrude, 
можно удалять любые ребра, а не только крайние. 

Настройки NURBS расположены в окне Свойства. 
Группа Resolution устанавливает разрешение примитива для окна 3D View 

и рендера. Причем это можно сделать для разных измерений. Опции Preview 
отвечают за окно 3D View, a Render – за обработку.  

Закладка Active Spline отвечает за внешний вид примитива. Все поля яв-
ляются уникальными для разных направлений: 

– Cyclic (Зацикливание) – замыкание фигуры; 
– Bezier (Безье) – включите эти опции, если хотите, чтобы фигура выгля-

дела, как простая кривая без объема;  
– Endpoint (Конечные точки) – включение этих опций заставит примитив 

растянуться по всей решетке; Resolution (Разрешение) – качество примитива по 
координатам U и V. 

Особо нужно остановиться на опции Order. С ее помощью можно устано-
вить соответствие формы примитива с решеткой редактирования. 
 

Порядок выполнения работы 
 
1 Профиль. 
Запустите Blender и удалите (Delete) куб из автоматически созданной сце-

ны. Перейдите к виду сверху (Num7) и добавьте на сцену кривую Безье (Доба-
вить → Кривая → Безье, Add → Curve → Bezier). 

Включите режим редактирования (Edit Mode, клавиша Tab), выделите оба 
узла и преобразуйте их в векторные (клавиша V). 

Выделите одну вершину и щелчками левой кнопки мыши при нажатой 
клавише Ctrl добавьте новые узлы так, чтобы получилось сечение рамки для 
картины. Замкните контур, нажав Alt+C. 
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Сделайте три внутренних узла гладкими, как показано на рисунке 4.1. 
 

 
 
Рисунок 4.1 – Эскиз 
 
Перейдите обратно в режим работы с объектами (Object Mode) и добавьте 

еще одну кривую Безье (Добавить → Кривая → Безье, Add → Curve → Bezier). 
Преобразуйте все узлы в векторные. Добавьте еще 2 узла и замкните кон-

тур так, чтобы получился прямоугольник. Для того, чтобы точно выровнять уз-
лы, можно вводить их координаты на панели преобразований (клавиша N). 

Приведите в соответствие размеры сечения и контура-рамки. 
Выделите прямоугольный путь, перейдите на страницу свойств кривой 

(Object Data) и выберите в списке Форма скоса (Bevel Object) название кривой-
профиля, как представлено на рисунке 4.2. 

 

 
 
Рисунок 4.2 – Профиль 
 
2 Моделирование бутылки с помощью кривой. 
Запустите Blender. Загрузите в качестве фонового изображения картинку 

моделируемого объекта. Для этого необходимо вызвать панель свойств окна 3D 
View и в разделе Background Images загрузить файл. 

Переключитесь в режим вида Front View (NumPad l) в ортогональной про-
екции (NumPad 5). 

Добавьте в сцену примитив (Add → Curve → Bezier). По умолчанию он 
располагается в плоскости XY. Поэтому его нужно развернуть. Для этого тре-
буется установить на панели свойств в группе Rotation следующие значения:  
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X = 90; Y = -90; Z = 0. 

 
Увеличьте масштаб кривой так, чтобы она по вертикали совпадала с об-

разцом. 
По умолчанию сплайн имеет всего две контрольные точки. Для увеличения 

количества узлов редактирования нажмите Таb и выделите все клавишей А. 
После этого нажмите W. В появившемся меню Specials выберите функцию 
Subdivide. На кривой появится новая точка. Теперь можно новую вершину под-
гонять под контур примера: выделяете точку, переносите на нужное место, за-
тем с помощью рычагов настраиваете степень кривизны. Точно так же проис-
ходит работа и для всей части бутылки (рисунок 4.3, а). 

 
а)    б) 

 
 
Рисунок 4.3 – Создание сплайна 
 
Зададим толщину объекта. Для этого продублируем кривую в режиме ре-

дактирования. Нажмите клавишу А для выделения всех вершин и кнопку 
Duplicate на панели Tool Shelf. Передвиньте ее на нужное расстояние. Так как 
дубликат был создан в режиме редактирования, то он является частью нашей 
кривой. 

Закроем получившийся сплайн. Для это выравниваем нижние точки кри-
вой и нажимаем клавишу F или выполняем команду Make Segment в меню 
Curve. Точки должны объединиться новым сегментом. Аналогичную операцию 
совершим и над верхними точками (рисунок 4.3, б). 

Функция Spin доступна только для Mesh-объектов, поэтому выполним 
конвертирование сплайна в Mesh. Выделите кривую в режиме Object Mode и 
выберите пункт меню: Object → Convert to → Mesh from Curve / Meta / Surf / 
Text. 



 22

Перейдите в режим редактирования. Нажмите клавишу А и на панели Tool 
Shelf выберите команду Spin. Настройки данной команды представлены на ри-
сунке 4.4. 

В результате должна получиться модель, как на рисунке 4.5. 
Данный метод моделирования имеет один существенный недостаток. Если 

после преобразования кривой в Mesh-объект выглядит не корректно, то необ-
ходимо вернуться на этап редактирования профиля и повторить действия по 
преобразованию и вращению объекта сначала. 

 

 
 
Рисунок 4.4 – Настройки функции Spin 
 

 
 
Рисунок 4.5 – Модель бутылки 
 
3 Моделирование бокала с помощью управляющей кривой. 
Запустите Blender. В режиме просмотра Вид сверху добавите кривую 

Bezier Circle. Для этого нажмите сочетание клавиш Shift + А и выберите 
Curve → Circle. Переключитесь в режим Вид спереди и добавить объект Curve. 
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В объектном режиме работы сдвиньте кривую влево так, чтобы ее центр лежал 
точно на левой грани круга. 

Загрузите в качестве фонового изображения картинку моделируемого объ-
екта. В режиме просмотра Вид сверху измените размеры кривой Bezier Curve в 
соответствии с загруженным рисунком. 

Выберем объект Bezier Circle в окне Outliner. 
На панели свойств в разделе Кривые выбираем в качестве параметра для 

функции Bevel Object кривую профиль Bezier Curve.  
Полученный результат приведен на рисунке 4.6. 
 

 
 
Рисунок 4.6 – Модель бокала 
 
4 Создание бутылки с помощью Nurbs. 
Запустите Blender. Загрузите в качестве фонового изображения картинку 

моделируемого объекта. Для этого необходимо вызвать панель свойств окна 3D 
View и в разделе Background Images загрузить файл. 

Переключитесь в режим вида Front View (NumPad l) в ортогональной про-
екции (NumPad 5). Нажатием клавиш Shift+A вызовите меню Add и выберите в 
нем Surface – NURBS Circle. 

Используя команды дублирования объекта, перемещения и масштабирова-
ния, добейтесь, чтобы NURBS Circle описали форму бутылки (рисунок 4.7). 

Выберите все получившиеся NURBS Circle и в режиме редактирования 
Object Mode в разделе Transform выберите команду Join (J). В результате вы-
полнения данной команды образуется одна кривая, объединяющая в себе все 
выбранные объекты. 

Перейдите в режим редактирования объекта. В разделе Surface окна 3D 
View выберите команду Make Segments или нажмите кнопку F. Это позволит 
выполнить заливку полученного контура. 

Получилась готовая модель бутылки, как на рисунке 4.8. 
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Рисунок 4.7 – Использование NURBS 

 

 
 
Рисунок 4.8 – Модель бутылки 
 
Вопросы для самоконтроля 
 
1 Какие виды кривых используются в Blender? 
2 Что такое рычаг? 
3 Какие бывают типы рычагов? 
4 Какие операции можно проводить с кривыми? 
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5 Лабораторная работа № 5. Тела вращения 
 

Цель работы: изучить методы создания объемных моделей в Blender. 
 
Теоретические основы  
 
Сплайны – это мощнейший инструмент для создания обтекаемых, объем-

ных моделей. 
Примитивы Mesh имеют функцию Spin (Вращение). Суть ее заключается в 

том, что она создает копии объекта в процессе вращения его на определенный 
угол. В итоге получается, что достаточно сделать один сегмент модели и про-
вернуть его вокруг оси. Сплайны имеют одно неоспоримое преимущество пе-
ред Mesh-объектами – они оптимально подходят для создания плавных изгибов 
фигуры. 

 
Порядок выполнения работы 
 
Запустите Blender и удалите (клавишей Delete) куб из автоматически со-

зданной сцены.  
Переключитесь на вид сверху (Num7), в ортографическую проекцию 

(Num5). Добавьте окружность (Добавить → Кривая → Окружность, Add → 
Curve → Circle), ее радиус будет по умолчанию равен 1. Поставьте курсор на 
крайнюю левую точку окружности и добавьте кривую Безье (Добавить → Кри-
вая → Безье, Add → Curve → Bezier).  

Добавьте рисунок бокала на сцену. Щелкните по кнопке слева от имени 
файла, чтобы рисунок был «упакован» в blend-файл. Перейдите к виду сверху 
(Num7) и включите ортографическую проекцию (Num5), при этом рисунок 
должен появиться в рабочей области. Изменяя параметр Непрозрачность 
(Transparency), отрегулируйте прозрачность рисунка. Размер изменяется с по-
мощью параметра Размер (Size), а величины X и Y позволяют перемещать ри-
сунок в плоскости проекции. Расположите рисунок так, чтобы центральная 
точка основания ножки была в начале координат.  

Выделите кривую Безье, которая будет задавать профиль. Перейдите в ре-
жим редактирования (Edit Mode, клавиша Tab). Выделите все узлы и нажмите 
клавишу V, чтобы сделать их векторными, и постройте профиль бокала в виде 
ломаной линии. Ее начало и конец должны быть на оси Y (вертикальной оси, 
где будет ось вращения). Затем отрегулируйте профиль, преобразуя некоторые 
узлы из угловых в гладкие (автоматические) с помощью меню, которое появля-
ется при нажатии клавиши V. 

Перейдите в режим Работа с объектами (клавиша Tab), выделите окруж-
ность. На странице свойств объекта (Object Data) в поле Форма скоса (Bevel 
Object) выберите название кривой, которая задает профиль. Результат работы 
приведен на рисунке 5.1. 
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Рисунок 5.1 – Модель бокала 
 
Вопросы для самоконтроля 
 
1 Каким образом можно создать тело вращения в Blender? 
2 Как вставить рисунок? 
3 Как использовать функцию Spin? 
 
6 Лабораторная работа № 6. Материалы и текстуры 
 
Цель работы: приобрести навыки работы с материалами и текстурами в 

Blender. 
 

Теоретические основы  
 
Материал имеет огромное количество настроек, и все они располагаются 

на специальной панели окна Properties. Новый объект, добавленный в сцену, 
не имеет присоединенного материала. Сделать это можно двумя способами: 
либо создать новый материал, либо выбрать имеющийся из списка. В первом 
случае необходимо нажать кнопку на панели New. Обратите внимание на сти-
лизованное изображение сферы рядом с кнопкой New. При нажатии на нее по-
явится список имеющихся в сцене материалов. 

Режимы работы с материалом:  
– Surface (Поверхность) – стандартный режим работы материала, который 

устанавливается по умолчанию. В этом случае объект визуализируется как есть;  
– Wire (Решетка) – в этом случае рендерится структура объекта, т. е. ребра 

с вершинами без полигонов. Внешне это похоже на режим Wireframe окна 3D 
View;  

– Volume (Объем) – интересный режим, который позволяет обрабатывать 
объекты с сохранением их формы, как будто они заполнены объемным туманом;  

– Halo (Ореол) – структура объектов визуализируется в виде светящихся 
элементов. 
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Параметры закладок Transparency (Прозрачность), Mirror (Отражение) 
и Subsurface Scattering (Глубина рассеивания) отвечают за отражение и прелом-
ление лучей света.  

Цвет материала состоит из двух составляющих: основного (диффузного) 
и бликового (зеркального) шейдеров. Оба элемента имеют свои собственные 
настройки в соответствующих группах Diffuse (Рассеянный или диффузный) 
и Specular (Зеркальный). 

Группа Diffuse (Диффузный) образует так называемый основной цвет ма-
териала. По умолчанию он серый. Чтобы выбрать иной, нужно щелкнуть левой 
кнопкой мыши по образцу.  

Шкала Intensity позволяет установить интенсивность цвета. Выбор шей-
дерной модели осуществляется из меню Diffuse Shader Model (Диффузный 
шейдер). 

Для корректировки основного цвета материала Blender предлагает специ-
альный инструмент – Ramp (рамповый шейдер). В основе его работы лежит 
смешивание базового цвета с градиентной палитрой, которую пользователь 
устанавливает сам. 

Материалы Blender имеют особый режим Halo, который позволяет выво-
дить вершины объекта в виде светящихся элементов. Это не значит, что мате-
риал начинает функционировать наподобие источников света. В действитель-
ности свечение Halo не оказывает влияния на рядом находящиеся объекты.  

Под словом «текстура» в Blender понимается нечто большее, нежели про-
стой графический файл. Текстурами могут быть графические и видеофайлы, 
процедурные функции, карты смещения, рельефа и окружения. Все их можно 
комбинировать, смешивать с помощью различных алгоритмов и тем самым до-
биваться поставленной задачи.  

Все манипуляции с текстурами осуществляются на панели Textures окна 
Properties. 

Текстуры нельзя присоединять к объекту без материала. Сначала нужно 
добавить материал, а лишь потом создавать сами текстуры. 

Имеются три группы возможных текстур: 
– Процедурные – создание этих текстур осуществляется с помощью специ-

альных математических функций. К ним относятся: Blend, Clouds, Distorted 
Noise, Magic, Marble, Musgrave, Noise. Stucci, Voronoi, Wood. В большей степе-
ни все они являются результатом работы различных шумовых алгоритмов. 
Процедурные текстуры будут рассмотрены в соответствующем разделе;  

– Файловые – к ним относятся сторонние графические или видеофайлы, 
загружаемые в программу. Blender воспринимает эти текстуры так, как они 
есть. Кроме отдельных файлов имеется возможность создания своих собствен-
ных текстур непосредственно в Blender. Такой режим называется Texture 
Painting и будет рассмотрен отдельно;  

– Окружение – этот тип представляет всего одна текстура Environment 
Мар. Карта окружения дает возможность замены трудоемких по вычислению 
отражений в сцене готовой текстурой, которая создается особым образом самой 
программой. 
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Порядок выполнения работы 
 
1 Модель зонта. 
Запустите Blender и удалите куб, созданный автоматически. Создайте сфе-

ру. Добавить → Полисетка → UV-сфера (Add → Mesh → UV Sphere) и измени-
те (внизу слева от рабочего поля) число сегментов и колец: сделайте 8 сегмен-
тов (Segments) и 6 колец (Rings).  

Перейдите в режим редактирования (Edit Mode, клавиша Tab). Включите 
режим работы с гранями (Ctrl + Tab), отмените выделение всех граней 
(клавиша A). Проверьте, чтобы кнопка, которая ограничивает выделение только 
видимыми гранями (запрещает выделение на обратной стороне фигуры) была 
отключена. Перейдите к виду спереди (Num1). Нажмите клавишу B (выделение 
прямоугольником) и выделите 4 нижних кольца граней. Удалите их (Delete → 
Грани).  

Перейдите в режим работы с объектами (Object Mode, клавиша Tab). До-
бавьте кривую Безье (Добавить → Кривая → Безье, Add → Curve → Bezier). 
Поверните ее на 90 градусов вокруг оси X (клавиша R, затем X, затем набрать 
90 на клавиатуре, затем Enter). Перейдите в режим редактирования (Tab) и по-
стройте контур по форме ручки зонтика, представленного на рисунке 6.1. 

 

 
 
Рисунок 6.1 – Модель зонтика 
 
Перейдите на страницу свойств кривой (Object Data), включите свойство 

3D (трехмерная кривая), выберите в списке Заполнение (Fill) вариант Полно-
стью (Full) флажки Front (передняя сторона) и Back (задняя сторона). Затем из-
мените параметры блока Bevel (фаска): увеличьте глубину (Depth), она опреде-
ляет толщину ручки, и разрешение (Resolution) до 3 (гладкость поверхности). 

Перейдите на страницу свойств Материал (Material) и установите для руч-
ки материал коричневого цвета.  

Выделите купол зонтика, создайте для него новый материал и уменьшите 
интенсивность (Intensity) зеркального отражения до нуля (панель Specular).  

Перейдите на страницу свойств Текстура (Texture). Создайте новую тек-
стуру (кнопка Создать, New). В списке Тип (Type) выберите вариант Изображе-
ние или видео (Image or Movie). Затем щелкните по кнопке Открыть (Open) 
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и выберите файл с картинкой в формате jpg. Щелкните по кнопке слева от име-
ни файла, чтобы рисунок был «упакован» в blend-файл.  

На панели Отображение (Mapping) в поле координаты (Coordinates) выбе-
рите вариант UV (UV-развертка). Выберите тип окна Редактор UV / изображе-
ний (UV / Image Editor).  

Перейдите в режим редактирования (Edit Mode). Выделите все грани. Из 
нижнего меню Полисетка (Mesh) выберите пункт UV-развертка → Развернуть 
(UV Unwrap → Unwrap). 

Установите режим просмотра Текстура (Textured). 
Нажмите клавишу Num0, чтобы перейти к виду с камеры. Перейдите к ок-

ну Редактор UV/ изображений (UV / Image Editor). Щелкните по кнопке и вы-
берите рисунок в формате jpg. Уменьшите сетку, нажав клавишу S (scale). За-
тем нажмите клавишу G (grab) и переместить сетку по рисунку так, чтобы цве-
ток находился сбоку. 

Результат работы представлен на рисунке 6.2. 
 

 
 
Рисунок 6.2 – Зонт 
 
2 Ваза с тканью. 
Добавьте в сцену сферу, перейдите в режим редактирования (Tab) и пере-

ключитесь на тип отображения Wireframe. Также переключитесь на ортографи-
ческий вид (NumPad5) и перейдите на вид спереди (NumPad1). 

Если Ваша сфера в данный момент выделенная, то снимите выделение, 
нажав клавишу A. Нажмите клавишу B, выделите верхнюю часть сферы и уда-
лите выделенные вершины (рисунок 6.3, а). 

Снова нажмите клавишу B, выделите нижнюю часть сферы, как показано 
на рисунке 6.3, б. 

Выделив нижнюю часть, нажмите клавишу S (масштабирование), затем Z 
(масштабирование вдоль оси Z), 0 (ноль) и Enter. Выполнив данное действие, 
вернитесь в режим отображения Solid и переключитесь из режима редактиро-
вания в объектный режим (рисунок 6.4). 
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а)      б) 

  
 
Рисунок 6.3 – Удаление вершин 
 

 
 
Рисунок 6.4 – Масштабирование вазы 
 
Теперь необходимо добавить толщину для вазы и сгладить ее. Для этого 

добавьте модификатор Solidify и установите основной параметр Thickness 0.07 
(рисунок 6.5). Затем добавьте модификатор Subdivision Surface и установите его 
значение равным 2. Наконец, установите тип шейдера Smooth (T > Smooth). 

Чтобы добавить материал для вазы, переключитесь с Blender Render на 
Cycles Render. Перейдите на вкладку материалов и создайте новый материал. 
Нажмите кнопку Use Nodes и в меню Surface выберите Glass BSDF (рису-
нок 6.6). 

Создадим поверхность, на которой будет стоять наша ваза. Добавьте в 
сцену плоскость и расположите ее под вазой. Увеличьте ее размер (S|20). На 
вкладке материалов создайте для нее новый материал и оставьте все настройки 
по умолчанию. 
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Рисунок 6.5 – Настройка толщины 
 

 
 
Рисунок 6.6 – Добавление материала 
 

 
 
Рисунок 6.7 – Создание поверхности 
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Приступим к созданию салфетки. Добавьте в сцену еще одну плоскость и 
увеличьте ее размер (S|3). Затем нам необходимо расположить ее так, как пока-
зано на рисунке 6.8. Для этого выполните следующий набор действий: (R/Z/45), 
(R/X/70), затем поднимите ее над вазой и немного сместите вправо (для более 
удобного позиционирования переключитесь на вид сбоку (NumPad3)). 

 

 
 
Рисунок 6.8 – Перемещение плоскости 
 
Теперь назначим материал для ткани. На вкладке материалов создайте но-

вый материал, измените Surface на Glossy BSDF, параметр Roughness установи-
те равным 1, и укажите любой цвет для вашей ткани (рисунок 6.9). 

Далее нужно максимально подразделить плоскость для более качественной 
симуляции ткани. Для этого выделите ее, перейдите в режим редактирования и 
в меню Add (на панели инструментов) нажмите кнопку Subdivide (рисунок 
6.10). Параметр Number of cuts установите равным 50. 

 

 
 
Рисунок 6.9 – Назначаем материал для ткани 



 33

 
 
Рисунок 6.10 – Деление плоскости 
 
Сейчас необходимо добавить три модификатора для нашей салфетки. 
Добавляйте их строго в следующей последовательности (рисунок 6.11, а): 
1) Модификатор Cloth (все настройки по умолчанию); 
2) Модификатор Solidify (все настройки по умолчанию); 
3) Модификатор Subdivision Surface. Параметр Subdivisions установите 

равным 2. 
Также установите тип шейдера для ткани Smooth (T > Smooth). 
 
а)       б) 

   
 
Рисунок 6.11 – Настройки для ткани 
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Перейдите на вкладку физики и в меню Cloth измените одну из предуста-
новленных настроек для ткани на Cotton. Значение Quality увеличьте c 5 до 10. 
Также отметьте следующие настройки в меню Cloth Collision (рисунок 6.11, б). 

Выберите вазу и на вкладке физики нажмите кнопку Collision. Также сде-
лайте для плоскости, которая выступает в качестве стола. Таким образом, наша 
ткань не будет проходить сквозь них, а будет с ними взаимодействовать. 

Теперь можно запустить анимацию (Alt + A) и дождаться пока ткань упа-
дет. Затем выберите подходящий Вам кадр, который будет участвовать в фи-
нальном рендере (рисунок 6.12). 

Теперь выберите лампу, немного опустите ее и расположите немного сбо-
ку от вазы. Затем перейдите на вкладку лампы, увеличьте параметр Size до 5, 
нажмите кнопку Use Nodes и установите параметр Strength равным 2000 (рису-
нок 6.13). 

 

 
 
Рисунок 6.12 – Кадр анимации 
 

 
 
Рисунок 6.13 – Настройка Use Nodes 
 
На вкладке мира установите полностью черный цвет фона и расположите 

камеру так, как Вам нужно. На вкладке рендера увеличьте количество семплов 
до 2000 и нажмите F12. 
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Вопросы для самоконтроля 
 
1 Как добавить материал и текстуру?  
2 Какие существуют режимы работы с материалом? 
3 Какие существуют группы текстур? 
 
7 Лабораторная работа № 7. Рендеринг 

 
Цель работы: приобрести навыки рендеринга проекта. 
 
Теоретические основы  
 
Рендер (Render) – это система визуализации проекта и сохранение резуль-

тата в виде графических или видеофайлов. 
Blender имеет три встроенных обработчика, которые можно найти и вы-

брать в меню Engine (Движок): 
– Blender Render – это самый первый визуализатор программы, он исполь-

зуется по умолчанию; 
– Blender Game – движок для визуализации сцены в режиме реального 

времени;  
– Cycles Render – движок из разряда unbiased-рендеров (т. е., так называе-

мых безошибочных). Позволяет получить фотореалистичную картинку. 
В верхней части панели Render присутствуют три большие кнопки, кото-

рые позволяют запустить процесс обработки: это Image (Картинка), Animation 
(Анимация) и Audio (Звук). 

Настройки изображения выполняются на закладке Dimensions (Размеры). 
Blender поддерживает технологию Motion Blur (Смазывание движения). 

Технически это выглядит, как создание дополнительных шагов движения объ-
ектов в одном и том же кадре. 

Cycles Render – представитель славной плеяды так называемых безоши-
бочных рендеров (Unbiased Rendering). В отличие от обычных, стандартного 
обработчика Blender или иных, эти unbiased-рендеры позволяют обрабатывать 
картинку так, как она должна выглядеть в реальности, без каких-либо искаже-
ний, допущений или погрешностей. Если это тень – тень настоящая. Отражение 
и преломление – выглядят, как в природе. 

К плюсам такого типа рендера относятся точные расчеты физических эф-
фектов: глобальное освещение, мягкие тени, отражения и преломления, глубина 
резкости 

 
Порядок выполнения работы 
 
Запустите Blender и удалите куб, созданный автоматически. Добавьте 

плоскость Добавить → Полисетка → Плоскость (Add → Mesh → Plane) и уве-
личьте ее размеры в 10 раз (нажмите клавишу S, наберите на клавиатуре «10» 
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и нажмите Enter). Временно скройте плоскость, нажав на значок с изображени-
ем глаза на панели Структура проекта (Outliner).  

Добавьте на сцену цилиндр (Добавить → Полисетка → Цилиндр, Add → 
Mesh → Cylinder). Включите режим редактирования (Edit Mode, клавиша Tab) 
и перейдите к виду спереди (Num1) и включите ортографическую проекцию 
(Num5). Проверьте, чтобы кнопка, которая ограничивает выделение только ви-
димыми гранями (запрещает выделение на обратной стороне фигуры), была от-
ключена. Нажмите клавишу B (выделение прямоугольником) и обведите левой 
кнопкой мыши все нижние вершины. 

Включите кнопку (привязка) под окном трехмерной проекции и выберите 
справа от нее вариант (привязка к координатной сетке). Переместите выделен-
ные вершины вверх так, чтобы они оказались на уровне Z = 0. Затем отключите 
привязку.  

Вернитесь в режим работы с объектами (Object Mode, клавиша Tab) и уве-
личьте высоту цилиндра: нажмите клавишу S (масштабирование), затем клави-
шу Z (ограничить действие осью Z), наберите на клавиатуре «10» и нажмите 
Enter.  

Перейдите на страницу свойств Модификаторы (Modifiers), щелкните по 
кнопке Добавить модификатор (Add Modifier) и выберите модификатор Массив 
(Array). Установите в параметрах модификатора Количество (Count) равное 3, 
и смещение 3 по оси X. Должно получиться 3 колонны. Добавьте еще один мо-
дификатор Массив (Array), теперь со смещением 3 по оси Y. Должно получится 
3 ряда по 3 колонны. 

Перейдите к виду сверху (Num7). Включите показ плоскости и поставьте 
колонны в центр плоскости. Выделите плоскость и увеличьте ее в 3 раза.  

Установите камеру так, чтобы вид с нее был примерно таким, как на ри-
сунке 7.1. 

 

 
 
Рисунок 7.1 – Установка камеры 
 
Выведите на экран панель преобразований (клавиша N), увеличьте Мас-

штаб (Scale) по оси Х до 50 и поверните плоскость вокруг оси Z так, чтобы гра-
ница плоскости стала параллельной горизонту. Вытащите второе окно и выбе-
рите тип окна Редактор UV/изображений (UV/Image Editor). В этом окне будет 
показываться результат рендеринга. Выполните рендеринг (F12). 
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Переместите источник света вверх так, чтобы он располагался над колон-
нами. Перейдите на страницу свойств лампы (Object Data) и увеличьте мощ-
ность лампы (параметр Энергия, Energy) до 5. 

В нижней части окна Редактор UV/изображений (UV/Image Editor), выбе-
рите Cлот 2 (Slot 2). Выполните рендеринг. 

Измените тип лампы на Cолнце (Sun), перейдите к слоту 3 и выполните 
рендеринг. Обратите внимание на расположение теней. 

Измените тип лампы на Прожектор (Spot). Установите угол конуса 37 гра-
дусов (Размер, Size), включите эффект «Гало» (Halo) и установите его Интен-
сивность (Intensity) равной 0,1. Используя перемещение и вращение на видах 
спереди и сбоку, настройте лампу так, чтобы она светила сверху на колонны. 
Перейдите к слоту 4 и выполните рендеринг. 

Измените тип лампы на Полусфера (Hemi), уменьшите ее энергию (Energy) 
до 0,5. Перейдите к слоту 5 и выполните рендеринг. 

Измените тип лампы на Область (Area), перейдите к слоту 6 и выполните 
рендеринг. 

Перейдите на страницу свойств Мир (World). Установите голубой цвет в 
поле Цвет горизонта (Horizon Color). Выполните рендеринг, посмотрите, что 
изменилось. 

Сделайте плоскость невидимой при рендеринге, щелкнув на значке с изоб-
ражением фотоаппарата. 

Установите белый Цвет горизонта (Horizon Color) и синий Цвет зенита 
(Zenith Color). Отметьте флажок Смесь неба (Blend Sky) и выполните            
рендеринг.  

Отметьте флажок Псевдонебо (Paper Sky) и выполните рендеринг. 
Отметьте флажок Реальное небо (Real Sky) и выполните рендеринг. 
Сделайте плоскость видимой при рендеринге, щелкнув по кнопке с изоб-

ражением фотоаппарата в окне Структура проекта (Outliner). Перейдите к виду 
сверху (Num7) и добавьте пустой объект (Добавить → Пустышка → Куб, 
Add → Empty → Cube) напротив камеры на самый край плоскости. На виде 
спереди переместите его по вертикали так, чтобы его координата Z была равна 
нулю. 

Установите для камеры ограничение: она должна при любых перемещени-
ях быть направлена на только что созданный пустой объект. Выделите камеру, 
перейдите на страницу свойств Ограничения (Constraints). Щелкните по кнопке 
Добавить ограничение объекта (Add Constraint), выберите ограничение Слеже-
ние (Track To) и выберите в поле Цель (Target) пустой объект Пустышка. 

В окне трехмерной проекции переключитесь на локальную систему коор-
динат (Local) и посмотрите, как направлены оси. На панели Constraints выбери-
те направление «–Z», а в поле Вверх (Up) – «Y». Это значит, что локальная ось 
Z камеры будет направлена в сторону, противоположную объекту, а ее ось Y – 
вверх. Вернитесь к глобальным осям координат (Global) координат и переме-
стите камеру немного вверх. Выполните рендеринг. 

В окне трехмерной проекции отмените выделение всех объектов (клави-
ша A). Перейдите на страницу свойств Мир (World), а затем – на страницу Тек-
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стура (Texture). Добавьте новую текстуру (кнопка Создать, New), оставьте ва-
риант Облака (Clouds) и выполните рендеринг. 

В списке Тип (Type) выберите вариант Изображение или видео (Image or 
Movie). Затем щелкните по кнопке Открыть (Open) и выберите файл sky.jpg. 
Щелкните по кнопке слева от имени файла, чтобы рисунок был «упакован» 
в blend-файл.  

На панели Предпросмотр (Preview) включите режим Мир (World, просмотр 
фона при рендеринге). Затем на панели Влияние (Influence) отключите флажок 
Смешение (Blend) и включите Горизонт (Horizon). 

Перейдите на страницу свойств Мир (World). Чтобы отключить влияние 
цветов, установленных на этой странице, отключите флажок Смесь неба (Blend 
Sky). Также отключите флажок Реальное небо (Real Sky), чтобы фоновый рису-
нок не искажался (не искривлялся). Выполните рендеринг. 

На странице свойств Мир (World) включите флажок Ambient Occlusion 
(подсветка теней) и установите Множитель (Factor, мощность подсветки) рав-
ный 0,1. Выполните рендеринг. 

 
Вопросы для самоконтроля 
 
1 Что такое рендер? 
2 Какие обработчики использует Blender для рендеринга? 
3 Какими преимуществами обладает Cycles Render? 
 
 
8 Лабораторная работа № 8. Полигональное моделирование 

 
Цель работы: научиться создавать и редактировать полигональные объекты. 
 
Теоретические основы  
 
Термин «Boolean» чаще всего используется в программировании для обо-

значения примитивных логических операций, где результатом является значе-
ние True (Правда) или False (Ложь). В компьютерной ЗD-графике подобным 
словом обозначается способ взаимодействия двух объектов и создания на их 
основе смешанного результата. 

Для использования булевой функции в Blender обязательно нужны два 
объекта. К одному из них присоединяется специальный модификатор Boolean. 

Настройки модификатора Boolean: 
– меню Operation (Операция) – позволяет выбрать способ взаимодействия 

двух примитивов: Intersect (Пересечение); Union (Объединение); Difference 
(Различие); 

– поле Object (Объект) – название второго примитива для действия. При 
щелчке появляется меню, где можно выбрать объект из списка. 
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Работа модификатора Boolean происходит в реальном времени. После вы-
бора нужной операции и установки взаимодействующего объекта можно мани-
пулировать примитивами и подгонять их под нужный результат. 

 
Порядок выполнения работы 
 
1 Модель пуговицы. 
Откройте Blender. Удалите куб, созданный по умолчанию: нажмите Delete, 

затем Enter. Создайте полигональный цилиндр (Add – Mesh – Cylinder) с пара-
метрами Vertices = 64, Radius = 1, Depth = 0.5. Установите для цилиндра LocX = 
LocY = LocZ=0. 

Создайте полигональную сферу (Add – Mesh – UV Sphere) с параметрами 
Segments = 32, Rings = 64, Size = 2. Установите для сферы LocX = LocY = 0, 
LocZ = 2,03. 

Выделите цилиндр. В окне кнопок перейдите на вкладку «Модификато-
ры». Нажмите кнопку «Add Modifier», в открывшемся списке выберите Boolean. 
Выберите тип операции (Operation) – Difference (вычитание), укажите вычитае-
мый объект «Сфера» (Object – Sphere), нажмите кнопку Apply. Для просмотра 
результата удалите сферу и поверните сцену. 

Создайте полигональный цилиндр (Vertices = 16, Radius = 0,2). Установите 
для цилиндра LocZ = LocY = 0, LocX = -0,375. Выполните вычитание созданно-
го цилиндра из заготовки пуговицы. 

Переместите цилиндр в позицию LocZ = LocY = 0, LocX = 0,375. Выпол-
ните вычитание из заготовки пуговицы. Полученная модель представлена на 
рисунке 8.1. 

 

 
 
Рисунок 8.1 – Модель пуговицы 
 
3 Модель пружины. 
Удалите куб, созданный по умолчанию. Переключитесь на вид сверху 

(Num 7). Создайте сечение пружины: добавьте в сцену полигональное кольцо 
(Add → Mesh → Circle) с количеством вершин 15. 

Перейдите в режим редактирования подобъектов. Выделите одну вершину 
(любую), скопируйте ее (Shift + D), переместите копию вершины в сторону. Со-
здайте путь скручивания: не снимая выделения с копии вершины, удерживая 
кнопку Ctrl, щелкните левой кнопкой мыши над предыдущей вершиной. 
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Выделите все вершины (2 раза кнопка А), на панели Mesh Tools нажмите 
на кнопку Screw, укажите следующие параметры: Steps (количество шагов) = 9, 
Turns (количество витков) = 5. 

Удалите вставку внутри пружины: выделите любую одну вершину, кото-
рая принадлежит этой вставке ⇒ расположите курсор мыши над вставкой и 
нажмите клавишу L (выделение связанных вершин), обратите внимание на то, 
что должны быть выделены вершины, которые принадлежат только вставке, ⇒ 
нажмите клавишу Del. В открывшемся меню выберите пункт Vertices. Повто-
ряйте до тех пор, пока вставка не будет удалена. 

Выйдите из режима редактирования подобъектов. Сгладьте модель пружи-
ны кнопкой Smooth. Готовая модель пружины приведена на рисунке 8.2. 

 

 
 

Рисунок 8.2 – Модель пружины 
 
4 Модель забора. 
Удалите куб, перейдите в вид сверху. Создайте полигональную плоскость 

(Add → Mesh → Plane), задайте ScaleX = 0.5, ScaleY = 2. 
Перейдите в режим редактирования подобъектов (Тab), выделите верхнее 

ребро, вызовите Специальное меню (W) → Subdivide. Переместите созданную 
на предыдущем шаге вершину. 

Перейдите в вид спереди. Выделите все вершины, примените выдавлива-
ние (Extrude), выйдите из режима редактирования подобъектов, поверните по-
лучившуюся модель на 90 градусов по оси X. 

Примените модификатор Array (массив): во вкладке Modifiers нажмите 
кнопку Add Modifier и выберите модификатор Array (Массив). 

Самостоятельно дополните модель, как на рисунке 8.3. 
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Рисунок 8.3 – Модель забора 
 
Вопросы для самоконтроля 
 
1 Какие Boolean операции доступны в Blender? 
2 Как выполняется работа модификатора Boolean? 
3 Приведите примеры использования модификатора Boolean? 
 
9 Лабораторная работа № 9. Анимация 

 
Цель работы: изучение приемов создания анимации в Blender. 
 
Теоретические основы  
 
В Blender можно выполнить 4 вида анимации: 
1) анимация объектов в сцене – могут быть анимированы любые манипу-

ляции с объектами, в том числе масштабирование, перемещение и т. д.; 
2) внутренняя анимация – возможности изменения внутренней структуры 

объекта; 
3) скелетная анимация – использование таких вспомогательных объектов, 

как «кости» для анимации сложных моделей; 
4) физика – анимация с учетом законов физики. 
Перечисленные виды анимации могут быть применены как к разным объ-

ектам, так и к одному. 
Одним из основных понятий анимации является понятие «ключевого кад-

ра». Ключ – это способ фиксации текущих параметров объекта в определенный 
момент времени. Таким образом, для создания простейшей анимации в сцене 
достаточно установить начальный и конечный ключевые кадры, а программа 
дополнит недостающие фазы движения. Любые зафиксированные параметры 
объекта можно изменять, добавлять или удалять. В свою очередь и ключи под-
даются редактированию – перемещению их по временной шкале. 

В Blender имеются несколько встроенных редакторов для корректировки 
ключей, их значений и анимации в целом: 

1) Timeline (Временная шкала). Удобное средство для управления про-
смотром анимации в целом. Представляет собой временную шкалу, отобража-
ющую ключи выделенного объекта и снабженную интерфейсными элементами 
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для проигрывания анимации. Здесь нет возможности редактирования парамет-
ров ключей; 

2) Graph Editor (Редактор кривых). Используется для просмотра и редакти-
рования ключей выделенных объектов. Каждый зафиксированный параметр 
представлен в окне редактора в виде кривой. С помощью кривых можно точно 
настраивать поведение объекта; 

3) Dope Sheet (Таблица ключей). Редактор, предлагающий несколько ре-
жимов для различных видов анимации, но с одинаковым интерфейсом и управ-
лением: 

– Dope Sheet – режим управления ключами с параметрами всех объек-
тов, участвующих в анимации. Используется для точной подгонки времени вы-
полнения анимации конкретного объекта по отношению к сцене. Это уже ре-
дактор более высокого уровня и по сравнению с Graph Editor не имеет возмож-
ности корректировки параметров ключа; 

– Action Editor (Редактор действий) – аналогичный режим, но только 
для выделенного объекта. Позволяет создавать так называемые действия 
(Action); 

– Shape Key Editor (Редактор ключей формы) – режим для управления 
внутренней анимацией объекта. 

4) NLA Editor (Редактор NLA). Высокоуровневый редактор для оконча-
тельного монтажа сценической анимации. Вся анимация представлена в виде 
элементов (действий), которые можно перемещать (сдвигать во времени), из-
менять скорость, тиражировать. 

В одном ключевом кадре могут одновременно находиться координаты 
объекта, его размер, ротация. Их можно устанавливать и редактировать незави-
симо друг от друга. В анимации Blender такие фиксированные параметры назы-
ваются ключевыми каналами. Возможно автоматическое и ручное добавление 
ключей. 

Большую часть окна Временной шкалы занимает шкала, разбитая на обла-
сти, подписанные цифрами. В данном случае цифры обозначают кадры, но мо-
гут выводиться значения в секундах. На заголовке окна имеются поля Начало и 
Конец, которые позволяют устанавливать начало и конец для всей анимации 
сцены. Именно этот кусочек будет проигрываться и обрабатываться рендером 
программы. Соседнее поле Текущий кадр (по умолчанию там стоит единица) 
указывает на активный кадр сцены. Таким образом, для установки нового клю-
ча необходимо выбрать сначала активный кадр. Это можно сделать, изменив 
значение в поле Текущий кадр либо щелкнув левой кнопкой мыши по шкале. 
В любом случае Временная шкала визуально отобразит в указанном месте вер-
тикальную зеленую полоску – курсор. Перемещая последний, можно просмат-
ривать анимацию. 

Способы воспроизведения анимации: 
– Синхронизация с видео – если какой-то объект в сцене отображает видео 

со звуком, то эта опция позволяет просматривать анимацию и прослушивать 
звук; 
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– Пропуск кадров – этот вариант пригодится для просмотра в реальном 
времени анимации сложной сцены, когда стандартный способ «Без синхрони-
зации» не способен обеспечить нужную скорость. В этом режиме Blender будет 
пропускать некоторое количество кадров, которые позволят обеспечить нуж-
ную скорость проигрывания. Количество кадров для реального времени берется 
из настроек рендера программы; 

– Без синхронизации – стандартный режим, когда анимация в окне воспро-
изводится без звука и не в режиме реального времени. 

Процесс создания анимации состоит из следующих шагов. 
1 Подготовить объект для запоминания первой позиции. 
2 Нажать клавишу I в активном окне 3D View и выбрать из меню нужный 

канал, например, перемещение, ротация или масштабирование. Остальные 
представляют собой возможные комбинации из этих трех. 

3 Включить кнопку записи. 
4 Выбрать другой активный кадр с помощью поля Текущий кадр или про-

сто передвинуть зеленый курсор в окне Временная шкала. 
5 Передвинуть объект на новое место. 
6 Отключить кнопку записи. 
7 В принципе автоматическую запись использовать не нужно, если необ-

ходимо проставить только два ключа. 
При создании анимации с использованием временной шкалы скорость 

движения объекта может быть неравномерной, что не всегда соответствует тре-
буемой модели. 

Редактор кривых – это вспомогательный редактор для точной настройки 
анимации конкретного объекта с помощью кривых, которые визуально отобра-
жают изменение каналов во времени и пространстве. 

 
Порядок выполнения работы 
 
1 Движение планеты. 
Добавьте на сцену сферу (будущее изображение планеты). Добавьте к объ-

екту текстуру и материал. Например, как показано на рисунке 9.1. 
 

 
 
Рисунок 9.1 – Модель планеты 
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Установите следующий кадр – 50. Включите запись анимации и выполните 
небольшой поворот сферы (например, по оси Z). Установите второй ключ. 

Проигрывание анимации создаст эффект крутящейся планеты, но движе-
ние планеты при этом может быть неравномерным. 

Для редактирования скорости движения планеты выделите в окне Редактор 
кривых кривую, ответственную за координату Z (она должна быть синего цве-
та). Это можно сделать, щелкнув мышью непосредственно по кривой или про-
сто выделив канал Z в левой части окна. Переведите курсор мыши в область с 
кривыми и нажмите клавишу A для отметки всех вершин активного сплайна. 

Выполните действия: Канал → Режим экстраполяции → Линейная экстра-
поляция. Кривая после этого превратится в прямую, уходящую в бесконеч-
ность. Запустите анимацию и убедитесь, что сфера вращается с одинаковой 
скоростью вне зависимости от реально установленных ключей. 

2 Маятник часов. 
Создайте заготовку маятника (рисунок 9.2) из двух объектов: сферы и ци-

линдра. Выделите оба объекта и объедините их в один объект. Центр объекта 
после этого будет расположен посередине. 

 

 
 
Рисунок 9.2 – Заготовка маятника часов 
 
Необходимо перенести центра объекта в верхнюю его часть. Для этого вы-

полните следующие действия: Объект → Преобразование → Опорная точка  
к 3D-курсору. Эта команда создаст новый центр объекта в месте, указанном   
курсором. 

Выберите инструмент Перемещение и для поля Y задайте значение –10. 
Маятник после этого должен отклониться влево. 

Установите на панели Временная шкала первый кадр в качестве активного. 
Нажмите клавишу I в окне 3D-вид и выберите пункт Перемещение. На панели 
временной шкалы отобразится новый ключ. 

Установите в окне Временная шкала значение равное 25 для активного 
кадра. Измените в поле Перемещение Y панели свойств значение на –10. Маят-
ник качнется в правую сторону. 
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Установите ключ Перемещение для этого кадра. Финальный ключ будет 
располагаться для кадра 50. Измените активный кадр. Введите значение 10 для 
координаты Y группы Перемещение. Маятник переместится обратно влево. 
Установите ключ и для этой позиции. 

Попробуйте проиграть анимацию. Если маятник совершит одиночное ка-
чание из стороны в сторону, то заготовка сделана правильно. 

Чтобы анимация выполнялась циклически необходимо в Редакторе Графов 
выбрать кривую Y Euler Rotation и выполнить действия Канал → Режим экс-
траполяции → Зациклить. Это действие создаст копии образца и размножит его 
до бесконечности. Теперь маятник будет спокойно качаться из стороны в сто-
рону неограниченное время. 

3 Шахматы. 
Запустите Blender и удалите куб, созданный по умолчанию. Нажмите кла-

вишу N, чтобы показать панель свойств. Найдите на ней флажок-
переключатель Фоновые изображения (Background Images) и отметьте его 
стрелкой, слева от флажка раскройте группу элементов управления. 

Щелкните по кнопке Добавить изображение (Add Image), затем – по белой 
стрелке слева от надписи Не устанавливать (Not Set), если эта панель закрыта. 
Затем щелкните по кнопке Open (Открыть) и выберите на диске файл рисунок 
фигуры короля. 

Щелкните по кнопке слева от имени файла, чтобы рисунок был «упакован» 
в blend-файл. Перейдите к виду спереди (Num1) и включите ортографическую 
проекцию (Num5), при этом рисунок должен появиться в рабочей области. Из-
меняя координаты X и Y, добейтесь, чтобы ось Z совпала с осью симметрии 
фигуры, а ось X проходила по низу основания. 

Установите курсор в центр сцены (в начало координат), нажав клавиши 
Shift+S и выбрав пункт всплывающего меню Курсор в центр (Cursor to Center). 
Нажмите клавиши Shift + A и добавьте на сцену окружность Безье (Добавить → 
Полисетка → Окружность, Add → Mesh → Circle). 

Перейдите в режим редактирования сеточной модели (Edit Mode, клавиша 
Tab). Выделите все вершины, нажмите клавишу S (масштабирование) и изме-
ните размер окружности так, чтобы ее диаметр совпал с диаметром основания. 
Нажмите клавишу E (выдавливание), затем клавишу Z (только вдоль оси Z) 
и переместите новые вершины вверх до первого изгиба контура. Теперь нажми-
те клавишу S и уменьшите размер нового контура в соответствии с профилем. 
Снова примените выдавливание и изменение масштаба, постройте               
«второй ярус». 

Аналогично постройте весь профиль. В самой верхней точке уменьшите 
масштаб до нуля (клавиша S, затем «0», затем Enter). После этого удалите сов-
падающие вершины, щелкнув по кнопке Удалить двойные вершины (Remove 
Doubles) на панели инструментов (в левой части окна). Убедитесь, что справа в 
заголовке окна появилось сообщение «Удалено 31 вершины» (Removed 
31vertices). 

Отключите фоновый рисунок – снимите флажок Фоновые изображения 
(Background Images). Выберите для короля черный цвет материала. 
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Установите курсор в центр сцены (в начало координат), нажав клавиши 
Shift + S и выбрав пункт всплывающего меню Курсор в центр (Cursor to Center). 
Нажмите клавиши Shift + A и добавьте на сцену арматуру – одиночную кость 
(Добавить → Скелет → Одна кость, Add → Armature → Single Bone). 

Переключитесь в режим просмотра Каркас (Wireframe, клавиша Z). Уве-
личьте размер кости так, чтобы она охватила всю нижнюю часть. Затем перей-
дите в режим редактирования (Edit Mode, клавиша Tab) и выделите верхний 
узел кости. Нажмите клавишу E (выдавливание), затем клавишу Z (вдоль оси Z) 
и «вытащите» вторую кость так, чтобы она перекрыла среднюю часть фигуры. 
Аналогично вытащите третью кость для верхней части (рисунок 9.3). 

Вернитесь в режим работы с объектами. Выделите сначала фигуру короля, 
а затем (при нажатой клавише Shift) – арматуру. Нажмите клавиши Ctrl + P, 
чтобы сделать арматуру родительским объектом для короля. Из всплывающего 
меню выберите вариант Скелетная деформация с автоматическими весами 
(Armature Deform With Automatic Weights). Это значит, что связь вершин с кон-
кретными костями будет установлена автоматически. 

 

 
 
Рисунок 9.3 – Шахматы 
 
С помощью списка режимов перейдите в режим определения положений 

(Pose Mode). Выделите какую-нибудь кость и попробуйте вращать ее (клави-
ша R). Фигура короля должна наклониться вместе с костью. Отмените враще-
ние кости. 

Установите длину анимации 100 кадров (параметр End) и сделайте теку-
щим первый кадр. Включите режим автоматической записи ключевых кадров, 
щелкнув по кнопке под временной шкалой. Выделите среднюю кость, немного 
наклоните ее в сторону и верните обратно (чтобы создать ключевой кадр, но 
оставить исходное положение короля). То же самое сделайте с верхней костью. 
Перейдите в кадр 25. Наклоните верхнюю и среднюю кости влево на 10 граду-
сов (клавиша R, набрать «-10», нажать Enter). 

Перейдите в кадр 50. Восстановите вертикальное положение короля. Для 
этого наклоните верхнюю и среднюю кости вправо на 10 градусов (клавиша R, 
набрать «10», нажать Enter). 

Перейдите в кадр 75. Наклоните верхнюю и среднюю кости вправо 
на 10 градусов. 
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Перейдите в кадр 100. Восстановите вертикальное положение короля. 
Остановите автоматическую запись ключевых кадров, щелкнув по кнопке. 

Нажмите клавиши Alt + A, чтобы посмотреть анимацию. 
Перейдите на страницу свойств Мир (World). Установите белый Цвет го-

ризонта (Horizon Color), включите Освещение от окружения (Environment 
Lighting) и уменьшите его интенсивность (Энергия, Energy) до 0,2. 

Перейдите на страницу свойств Рендеринг (Render). Установите размер 
кадра 400 на 400 пикселей, качество 100 %. Установите формат выходного 
файла MPEG, задайте имя файла (с расширением *.mpg). 

Нажмите клавишу Num0, чтобы перейти к виду с камеры. Настройте этот 
вид так, чтобы видеть всю анимацию (Shift + F, «режим полета»).  

Щелкните по кнопке Animation. 
 
Вопросы для самоконтроля 
 
1 Какие виды анимации можно выполнить в Blender? 
2 Что такое ключи и как с ними работать? 
3 Для чего нужен редактор ключей? 
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